Information Technology Handbook for Faculty

http://domin.dom.edu/infotech.htm

2006-2007 Academic Year

Dominican University
River Forest, Illinois
TABLE OF CONTENTS

LOGGING INTO THE NETWORK............................................................................................................................... 1
  What Are All Those Icons I See When I Click "My Computer"? ........................................................................ 4
  Accessing Your Network (N:) Drive From Off-Campus .................................................................................... 6
  I Have My Own Notebook Computer, Can I Connect to the Network In My Office? .................................... 10
  Are There Wireless Areas On Campus? ........................................................................................................ 11
  Clean Access................................................................................................................................................ 11

USING DOMINICAN'S E-MAIL.................................................................................................................................... 12
  Accessing Your E-Mail From Off-Campus ........................................................................................................ 12
    Windows XP Users ...................................................................................................................................... 13
    Windows 2000/Windows 98/Windows ME Users .......................................................................................... 13
    Logging Off From Off-Campus .................................................................................................................... 14
  What's My E-Mail Address? ............................................................................................................................ 14
  Why Can't I Send (Or Receive) Certain E-Mail Attachments? ......................................................................... 14
    File Size .................................................................................................................................................... 14
    File Type ................................................................................................................................................... 14
  I Got A Message Indicating My Allotted Space Was Full--Now What? .......................................................... 17
  How Do You Generate Those Automatic "I'm Out of the Office" Messages? .............................................. 17
  I Set the Out Of Office Assistant To Automatically Send Replies That I Am Off-Campus, But People Off-
  Campus Are Not Receiving Them--Why? ........................................................................................................ 18

WEB-BASED RESOURCES..................................................................................................................................... 19
  Blackboard.................................................................................................................................................... 19
  Retrieving Course Rosters and Submitting Grades Online ............................................................................. 19
  How Do I Get Web Pages Up? ....................................................................................................................... 20
  How Do I Get My Class Syllabi Up On The Web? .......................................................................................... 20
  Do You Have A Template I Can Just Fill In? ................................................................................................ 21
  How Do I Convert Something to HTML For The Web? ................................................................................ 21
  Can My Students Have Web Pages? ............................................................................................................ 22
  Can I Access My Web (I:) Drive From Off-Campus? .................................................................................... 22

SOFTWARE INFORMATION................................................................................................................................. 24
  Which Software Packages Does Dominican Support? ................................................................................... 24
  How Do I Learn About the Software Supported by Dominican? ................................................................. 24
  What Software Is Loaded Where? ................................................................................................................ 24
  I Found A Software Package That's Perfect For My Class. How Do I Get It Loaded Onto Technology Center
  Computers? ................................................................................................................................................. 25
  Can I Get A Copy Of Programs For Use At Home? ....................................................................................... 25

COMPUTER CLASSROOMS.................................................................................................................................... 26
  How Do I Get a Computer To Use In the Classroom For Myself? ................................................................. 26
  How Do I Get a Classroom With Computers For Each Of My Students? ..................................................... 26

NUMBERS TO CALL............................................................................................................................................... 27
  General IT Help Desk Number: 6832 ............................................................................................................. 27
  Classroom Equipment Problems................................................................................................................... 27
  IT HelpDesk Web Site................................................................................................................................. 27
LOGGING INTO THE NETWORK

All Dominican faculty members are required to obtain a network account. Yes, that includes adjunct faculty, too. The primary reason for this is that Dominican e-mail is an official method of communication for the University. Many important messages from the Office of the President, Office of the Provost, etc., are sent to Dominican e-mail addresses. If you have not yet applied for a network account, printed forms are located at the Lab Assistant desk in the Technology Center or can be found in PDF (Adobe Acrobat) format at:

http://domin.dom.edu/documents/network_facstaff.htm

Once you've filled out the application properly, return it to the Tech Center where a Lab Assistant will check your Dominican faculty ID. Depending on volume, the account should be created in 1 to 2 work days. (You can also fax a filled-out form to: 708-488-5111.)

When you have your user name and password you can go to any Windows-based office or laboratory computer to logon to our network. Most likely, the first screen you see upon turning on a PC will be a "Welcome to Windows" screen asking you to press \texttt{CTRL+ALT+DELETE} to logon. After doing so, you will see a screen such as this:

In most cases, your \textbf{User name:} is the first letter of your first name followed by your last name. So, if your name is \textbf{Raymond Johnson}, your user name would be \textbf{rjohnson} . After typing it in, press the \texttt{Tab} key on your keyboard to move down to the \textbf{Password:} field, or just click with your mouse in the \textbf{Password:} box. (You selected your \textbf{Password} when you filled out the network account form--even we can't tell you what it is!) Note that the Password is \textbf{case sensitive}.

If you have a logon screen that shows a box labeled \textbf{Log on to:} , as shown on the screen following, this is Windows' way of asking for a domain name. In our case, the domain name is \textbf{DOM}. This should be there by default.
Click **OK**. Congratulations--you are now logged into the Dominican University network!

**CAUTION: REMEMBER TO LOGOFF WHEN FINISHED!!!**

Even in the privacy of your office, it's always a good idea to LOGOFF of the network whenever you are finished with your work. (You don't really want people looking at your e-mail, checking the contents of your network drive, and other potentially malicious things, do you?) In addition, staying logged onto the network overnight is one of the leading causes of the "my computer isn't working this morning" service calls that are received. If a network server should go down for some reason overnight, it can wreak havoc on a computer that has remained logged in.

To logoff, click the **start** button on the Windows desktop, then click the command **Log Off**, as shown below:

You will then see the following confirmation screen:

Simply click **Log Off**, and you will be back at the Windows screen prompting you to press **CTRL+ALT+DEL**.
Should I Turn OFF My PC?

It is generally best to NOT turn off your PC when you leave the office--just log off the network as described above. One reason for this is that from time to time, Microsoft issues various security updates to the Windows operating system. Our IT department will "push" the most critical updates out to your machine, which requires that your machine be turned on, though not logged in. While there will usually be an e-mail ahead of time to alert you to whenever these critical updates are due out, it's probably easiest just to leave your PC on all of the time. And no, we are not going to get into the debate as to whether or not this causes more wear-and-tear on the system; the "experts" are divided 50/50 on this topic.

RESTART YOUR PC FROM TIME TO TIME!

While we don't recommend turning your PC off all the time, we highly recommend restarting it every now and then. Whenever your computer is slower than usual or just plain unresponsive, this is the best thing for it. To do this, click the start button, and then Shut Down:

![Start button with Shut Down option]

From the following screen, make sure you specify Restart--not Shutdown, which would, of course turn OFF your machine!

![Shutdown options]

Be sure you do not have any floppy disks in your floppy disk drive, or else the Norton Antivirus software will give you a warning. After clicking OK, your machine will turn off but then restart again. (Now, if only us human non-machines could have as simple a solution when we slow down!)
What Are All Those Icons I See When I Click "My Computer"?

After logging in, double click on the My Computer icon on the Windows desktop if you'd like to see all the things you now have access to. It will look something like this:

![Image of My Computer window](http://domin.dom.edu/infotech.htm)

The Local Disk (C:), 3 ½ Floppy (A:), Removable Disk (D:), and CD Drive (E:) are drives that are on your own machine, the others are on our network. You will either have to click once over each of the above icons to see the full drive name or hover your mouse over the icon long enough for a description, since some are rather long--and rather similar in name. If you click the icon once, you will see the full name (and drive letter) either under the icon or over on the far left:

![Image of My Computer window with disk drives highlighted](http://domin.dom.edu/infotech.htm)
Here are the drives you will *most likely* be seeing, though these may vary a bit:

<table>
<thead>
<tr>
<th>Letter</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C:</td>
<td>Local Disk</td>
<td>This will always be your hard drive within your computer.</td>
</tr>
<tr>
<td>A:</td>
<td>3 1/2 Floppy</td>
<td>This will always be your floppy drive.</td>
</tr>
<tr>
<td>D:</td>
<td>Removable Disk</td>
<td>This will be a ZIP drive. <em>Most</em> PCs have a 250MB ZIP drive, though older units will have the 100MB drive.</td>
</tr>
<tr>
<td>E:</td>
<td>CD Drive</td>
<td>Your CD-ROM drive.</td>
</tr>
<tr>
<td>H:</td>
<td>shared on 'fileserv'</td>
<td>Directories shared by members of various academic departments. You will not have access to any folders that you do not have rights to.</td>
</tr>
<tr>
<td>I:</td>
<td><em>yourusername</em> on 'fileserv/facultyweb'</td>
<td>This is the web drive that is on our &quot;intranet&quot; at <a href="http://domin.dom.edu">http://domin.dom.edu</a>. Here is where your web pages should be saved. If you would like to put your syllabi on the web, we have instructions at <a href="http://domin.dom.edu/documents/syllabi.htm">http://domin.dom.edu/documents/syllabi.htm</a>. Anything on this drive will be <em>accessible</em> via the web, though only <em>you</em> have rights to add, delete, or change the contents of items on this drive. You should <em>not</em> put anything that is of a private nature on this drive, since we are &quot;googled.&quot; You have a healthy 500 MB limit of space on this drive--up from our previous limit of 200 MB. You can also add/delete items on this drive from home; see the next section for details.</td>
</tr>
<tr>
<td>N:</td>
<td><em>yourusername</em> on 'fileserv/faculty'</td>
<td>This is your <em>network</em> drive. This is where you should be saving your files as a backup in case your hard drive should ever crash--which will inevitably happen at a very inconvenient time. NO ONE else has rights to this directory or (apart from our network administrators) can even see it. You can safely place private items on this drive. You now have a <strong>500 MB</strong> limit of space on this network drive (it was previously 200 MB)--more than enough to store backup copies of <em>Word</em> documents, <em>Excel</em> workbooks, etc. This <em>drive is accessible to you from off-campus</em>; see the next section for details.</td>
</tr>
<tr>
<td>P:</td>
<td>New Pibbles_ver9 on 'Admin2k'</td>
<td>Used by those folks who rely on the CMDS/Jenzabar administrative software package. As a faculty member, you can likely ignore this drive altogether.</td>
</tr>
<tr>
<td>S:</td>
<td>FacultyShared on 'fileserv'</td>
<td>This is a shared directory used primarily by instructors in computer science-related areas where students can retrieve needed files for a program or assignment.</td>
</tr>
<tr>
<td>W:</td>
<td>Web on 'fileserv'</td>
<td>Files from our &quot;intranet&quot; which, for the server to be public on the web, must be seen by all. You cannot, however, add or delete files from this drive. This is <em>NOT</em>, therefore, the place for you to add files to our &quot;intranet&quot;--those should be on your I: drive. If you have a departmental site on our &quot;intranet,&quot; however, this drive is indeed the place where you will post files.</td>
</tr>
</tbody>
</table>

If you hook up one of those removable USB "flash drives" (everyone calls them something else--but if you have one, you know it) it will appear as a *removable disk* at the first available drive letter after your CD-ROM drive.

**Disconnecting Your USB ("Flash") Drive Correctly**
To avoid data loss to your USB drive, do NOT simply yank it out of the PC. Instead, hover your mouse over the little "green arrow" icon that is in the system tray in *Windows XP* (see screenshot below--you should see the words *Safely Remove Hardware* when you hover your mouse over it), and then click it. You'll see the words *Safely remove USB Mass Storage Device*. Just click and you'll soon see a confirmation message that it's safe to remove your USB.
Bye-bye Floppy Disks and ZIP disks
Floppy drives and ZIP drives are slowly but surely going the way of the dinosaur, black-and-white television, and (one could only hope) Britney Spears. Newer PCs on campus will not have them. The sooner you start using a USB drive the better!

Save Frequently/Back Up Often
Unless you are particularly fond of having to re-create all of your documents from scratch, we strongly encourage you to make back-up copies of all of your documents on a USB (flash) drive, or better yet, on your network drive (N: drive), which is backed up by our network administrators. Your web drive (I: drive) is not a good place for confidential documents; although no one else can post documents there, people can access them via the Internet.

Accessing Your Network (N:) Drive From Off-Campus

If you are off-campus and need access to a file that you know you left on your network (N:) drive, so long as you have access to the Internet, have Internet Explorer and are on a PC (sorry Mac users!), getting access to your N: drive is as easy as firing up your web browser. Before doing this, however, please note that this is not encrypted over the Internet. Therefore, it's not recommended for files of a sensitive nature (such as financial information, documents with your credit card number on it, etc.)

With that caveat, here are the steps to take:

1. Click the File...Open drop-down menu in Internet Explorer. (Do not type in an address in the usual address bar!)
2. In the ensuing dialog box, click the checkbox for Open as Web Folder. (See screenshot below.)
3. Type in the following address:
   \[http://fileserv.dom.edu/faculty/yourusername\]

As an example, see the screenshot below for a faculty member with the user name rjohnson:
4. Click **OK**, and you will soon see a login box. The box you see will depend on your operating system. If you are on anything below the WindowsXP operating system (such as Windows 2000), you will see a screen requesting your user name, password, and domain. Type in your Dominican network user name (do NOT include the @dom.edu part--just type the user name), but you must precede your name with **dom\** (that's the backslash above the Enter key). Enter your password, then click **OK**.

If you are on the WindowsXP operating system, you will see a similar dialog box. Again, you **must** precede your user name with: **dom\**, (the domain name and the backslash above the Enter key):

5. Click **OK**. Be patient! Depending on your connection speed to the Internet, you may have a wait a bit before your directory listing finally comes up in your browser window. When it does, it will look something like this:
6. Assuming you would like to get files from your N: drive onto your home machine, just find the file you want and single-click on the icon next to the file name. You can then click the Edit drop down menu in your browser, and then click Copy.

(continued on next page)
7. Next, you can click on the **My Computer** icon or go to **Windows Explorer** on your home machine, get to the folder you want to place the file in, and then click the **Edit** drop-down menu, and then **Paste**. (Or, as seen below, you can just right-click anywhere in the folder, and click **Paste** from the ensuing menu).

8. You will then see your file!

You can do the same process in reverse to transfer files from your home machine to your N: drive at Dominican.
Why Can't I Get that MP3 File from My N: Drive (or MPEG File, or......)

For security and bandwidth reasons, certain file types are blocked by our firewall. Several file types are blocked simply to preserve network bandwidth and to prevent downloading of commercial content. Other file types can carry viruses more easily than others. Among the common file types that you will NOT be able to retrieve from your N: drive while off campus include those with following file extensions:

- .bat
- .mp3
- .com
- .mpeg
- .cpl
- .pif

An up-to-date, complete listing of blocked file types is available at:
http://domin.dom.edu/Intranet/blockedfiletypes.htm. For your N: drive access, the listing to pay particular attention to is the first one, Blocked On All Protocols.

---

I Have My Own Notebook Computer, Can I Connect to the Network In My Office?

Yes, but you must have an up-to-date virus scanner installed or be willing to have us install one for you AND have the latest Windows security patches! Any user who (even unknowingly) spreads a virus on-campus that can be traced to his/her personal equipment will be in violation of the Information Technology Policy, which is posted in its entirety at the following address:

http://domin.dom.edu/documents/it_policy.htm

Our IT staff is more than willing to assist you in logging into our network using your own PC. More importantly, they will install for you (free of charge) a current copy of Norton Antivirus if you need an up-to-date virus scanner. (It will be up to you, however, to ensure that it is constantly updated. While connected to Dominican's network, updates will be distributed automatically.)

In addition, you want to ensure that you have installed the latest security patches from Microsoft. Many times, if your notebook is constantly connected to the network (and it is turned on, obviously!), these patches will be "pushed" out to your machine. If you are not always connected to the network, however, you will want to check on these security updates periodically by clicking the Start button, and then selecting Windows Update. (This is also accessible within Internet Explorer by clicking the Tools drop-down menu, then Windows Update.)
Are There Wireless Areas On Campus?

The Rebecca Crown Library has the largest area of wireless access, centered primarily in the Information Arcade on the lower level (near the Cyber Café), and the reading tables on all floors. The Library supports the 802.11a, b, and g protocols. There is also wireless access in the Technology Center, the Digital Media Classroom (Lewis 406), and the Grill. These areas support the 802.11b and g protocols.

When you login, be sure to login with your Dominican network ID for full access to the network (including your network drives), not a guest login. But first, check the Clean Access information below.

Clean Access

The first time you log into the network from a wireless hot spot and access the Internet on your browser, you will be redirected to the Clean Access site and be prompted to download and install the Clean Access Agent. This is for your protection and ours. Clean Access is designed to prevent "infected" computers from accessing our network. There is additional information from our Information Technology page. Head to http://domin.dom.edu/infotech.htm and click the link for Clean Access Information.
USING DOMINICAN’S E-MAIL

Dominican uses Microsoft Outlook as its e-mail program. If you have your own office on campus with your own PC (not shared with anyone else!), Outlook should be installed on your PC. Once you double-click the Outlook icon on your desktop, getting to your e-mail is easy: just click on the Inbox icon on the Outlook toolbar. (By default, your Inbox should be visible whenever you open Outlook, unless you have set the default view to something else):

If you are new to Dominican, please be sure to contact Information Technology to have your Outlook account set up.

Accessing Your E-Mail From Off-Campus

If you want to get to your e-mail from off-campus, or if you do not have your own office PC with Outlook installed on it, you can access your e-mail using the Web. This can be done from home, from the Technology Center on campus, from the Library...anywhere there is Internet access.

Go to the following address using a web browser: http://mail.dom.edu/exchange You will see a dialog box prompting you for your Dominican network user name and password. The dialog box differs depending on the operating system you are using, as discussed next.

On campus, it’s easiest to access the web-based Outlook simply by clicking the Outlook Email link from the default Campus News page (www.dom.edu/campusnews)
Windows XP Users

If you have *Windows XP* as your operating system, you will see the following dialog box. Be sure to precede your Dominican User Name with **dom\** (the letters **dom** following by the backslash located above the **Enter** key), as shown below:

All of the labs on campus have *Windows XP*, so this will be the procedure from on campus. (The **dom**, by the way, is for the name of the domain you are trying to login to.)

Windows 2000/Windows 98/Windows ME Users

The dialog box for older operating systems will differ, but the procedure is the same. Type in your User Name preceded by **dom\**. You may leave the **Domain** box blank:
Logging Off From Off-Campus

Be sure to click the Log Off button on the Web version of Outlook when finished! (It's towards the upper right-hand portion of the screen):

Additional help on using Outlook is available from our documentation page at: http://domin.dom.edu/documents/email.htm

What's My E-Mail Address?

If you would like to give out your Dominican e-mail address to colleagues, it will be in the form of username@dom.edu where username matches the name you use to login to the network. So, if your name is Pat Johnson, it will be: pjohnson@dom.edu (Please note that when addressing on-campus e-mails using Outlook, you do not have to include anything past the user name, assuming you are addressing it to someone at Dominican.)

Why Can't I Send (Or Receive) Certain E-Mail Attachments?

If you are having difficulty receiving some e-mail attachments from others, or if others are complaining they have not received them from you, there are two likely reasons: file size and file type.

File Size

The largest file attachment our e-mail server can receive or send out is limited to ten megabytes (10 MB; or 10000 KB). If you need to send or receive something larger than that, please contact our Help Desk at ext. 6832.

File Type

You do not need to be a "computer nerd" to have heard about the havoc that viruses have caused worldwide. E-mail attachments are a leading cause of such viruses; an unsuspecting user may double-click on an attachment and--presto!--you have an instantly malfunctioning computer. For that reason, any e-mail attachments with the extensions listed on the following page will be "caught" by our firewall. Many of these types are particularly notorious for containing executable files that may spread a virus, while others will typically consume large amounts of network bandwidth.
An up-to-date listing of all blocked file extensions is available at:
http://domin.dom.edu/Intranet/blockedfiletypes.htm

One of these file extensions, .zip, is a common file type used for compressed files. If you need to send a file attachment to someone that is .zip file, we recommend you change the file extension to one our firewall will allow to "pass through" (such as .doc) and then send it. You must, of course, then notify your recipient that you have done this so that they can change the extension back to .zip so that it can be used. Here's the step-by-step method for changing a file extension for those of you who may not know how. If your view of My Computer or Windows Explorer is already showing file extensions, skip the first part below and go to the next.

**Make sure you can see file extensions**

- Get into either My Computer or Windows Explorer.
- Click the Tools drop-down menu, and then Folder Options...
- In the dialog box, click the View tab (see screenshot on next page).
- Uncheck the checkbox labeled Hide file extensions for known file types, as shown on the next page, then click the OK button.

**Rename your .zip file**

- Once you can see your file extensions, again using either My Computer or Windows Explorer, single-click on the file name so that it is highlighted.
- Click the File drop-down menu, and then Rename. Or, simply right-click where the file name is highlighted, and choose Rename from the menu.
- Put your cursor in the file name, backspace over the .zip extension and rename the file with a .doc extension. (There is a screenshot of this on the next page.)
- You will receive a message box on the screen, giving you a dire warning: If you change a file name extension, it may become unstable. Are you sure you want to change it? Go ahead and click Yes.
If you cannot see the three letter extensions on your file names while in My Computer or Windows Explorer, make sure you uncheck this box first! You get here by clicking Tools>>Folder Options.

Find your file. Then, click the File drop-down menu, then Rename. Click your cursor in the file name, and you can backspace over the .zip extension and replace it, like in this example, with .doc.
I Got A Message Indicating My Allotted Space Was Full--Now What?

Faculty are allowed a system-wide limit of **500MB** (up from our previous limit of 200MB) in their e-mail box. Factors to consider include the length of your e-mail messages received and whether or not there are still attachments (these can really add up after awhile), as well as the other settings outlined below.

The best thing to do for desktop users of *Outlook* is to set up the **AutoArchive** feature in *Outlook* so that all messages after x number of days are moved directly to your hard drive rather than remaining on our e-mail server. In most versions of *Outlook*, AutoArchiving is set by clicking on the **Tools** drop-down menu, then **Options**, and then by clicking the **Other** tab on the dialog box that results. You will see an **AutoArchive...** button on the screen. Click it, and there will be a dialog box where you can set a variety of options, including setting a directory on your local desktop computer to where the messages can be moved, thus freeing up space on the network drive. You may also choose to not Archive specific folders by right-clicking over a folder name, and then clicking **Properties**. In the dialog box that follows, be sure to click the **AutoArchive** tab, and then click **Do not archive items in this folder**. If you need assistance with this process, contact the IT Help Desk at ext. 6832, or submit a ticket at [http://domweb.dom.edu/helpdesk/](http://domweb.dom.edu/helpdesk/) (also linked from our Information Technology page at the address you see on the top of every page of this document), or send an email to helpme@dom.edu.

The AutoArchive feature is not available in the Web-based version of *Outlook*. Users that are using only the Web-based version will have little choice but to clean out their mailboxes, though you can save messages one-by-one as text files if you choose.

All users will want to take a look at the following in *Outlook*:

- Have you deleted all messages that are in your **Sent Items** folder?
- Have you deleted all messages that have accumulated in the **Junk E-mail** folder?
- Have you deleted all messages in your **Deleted Items** folder? Much like the Windows Recycle Bin, anything deleted will stay here by default until you empty it on your own. (For desktop users of *Outlook*, this can be modified by clicking on **Tools>>Options** and clicking the **Other** tab, and checking the checkbox labeled **Empty the Deleted Items folder upon exiting**.)
- Check any other folders you have created. Are there old messages you can get rid of?
- Save attachments in folders on your hard drive or elsewhere rather than keeping them in your "IN" box.

How Do You Generate Those Automatic "I'm Out of the Office" Messages?

If you are using *Outlook* on the PC in your office, click the **Tools** drop-down menu, and then **Out of Office Assistant...**. You will then see a box to type your message within, and whether or not to turn it on. In the web version of *Outlook*, click the tab labeled **Options** to bring up a very similar screen:
I Set the Out Of Office Assistant To Automatically Send Replies That I Am Off-Campus, But People Off-Campus Are Not Receiving Them--Why?

The "Out of Office Assistant" will send automated replies only to people at Dominican. You should also know that the automated reply is sent only once per sender. This means if someone sends you a message today, they get the automated reply. If that same person sends you another message tomorrow, they will not get the automated reply, since they already had one sent to them. This is actually an intentional setting on the server. Here's why. Experience has taught us that many other e-mail servers, including those at AOL and Yahoo, will treat those automated replies such as the one generated by the Out of Office Assistant as spam and filter them out. So, even if they were allowed, many users would not be receiving the messages, anyway. Secondly (and more importantly), auto replies are a wonderful "spam magnet." The one thing those folks who send out spam messages absolutely love receiving is verification that a specific e-mail address exists. By sending an automated reply, you are doing just that, and in return will likely get treated to more spam!

If you are absolutely sure you want an automated reply sent to off-campus users, it is necessary to create a new Rule in Outlook (Tools>>Rules and Alerts...), although this can only be done from a PC that has Outlook loaded on it, as there is a different setup on the web version of Outlook. Start with a new "blank" rule, and follow the prompts so that you set the option to have server reply with a specific message. Note that this will also make the automated reply work each and every time someone sends you a message. If someone sends you 15 email messages, they will get 15 automated replies back. (You should also be aware that many Internet Service Providers will treat this message as spam!)

On the web version of Outlook, click the Rules tab (just above Options...see the screenshot on the previous page), click the New button to create a new rule, and follow the prompts on the form. Note that there is no capability to have the server send a message automatically using this method, as there is on the dedicated version of Outlook. The best you can do is have the message forwarded to another e-mail account. And frankly, if you are going to do that, you might as well just check your Dominican e-mail account anyway!
WEB-BASED RESOURCES

All of the resources in this section are linked from our ever-handly Campus News page at http://www.dom.edu/campusnews. This should be the default home page for browsers throughout campus, and you would be well-advised to make it a "favorite" at home, too.

Blackboard

Dominican has a courseware package called Blackboard. Instructors can post course-related documents, homework assignments, web links, have a discussion board, and even post grades using an online gradebook. (These grades are for your and your student's use only; they do not automatically go to the Registrar!) Blackboard use (and support) is restricted to faculty members who have attended a training workshop or who have previously used a Blackboard as an instructor (version 5 or 6) at another institution. E-mail Ken Black, Director of Faculty Development and Director of Teaching and Learning Technology at kblack@dom.edu to request creation of a Blackboard course. Blackboard workshops are typically held at the following times: late August (just before the annual faculty workshop), on the Friday of Long Weekend, in January before the Spring semester, and in May just after commencement.

Retrieving Course Rosters and Submitting Grades Online

Dominican's web-based service Campus Web allows instructors to retrieve class rosters online, submit grades directly to the Registrar online, and, for advisors, retrieve academic data on advisees. You need an ID number and PIN number to access Campus Web. If you do not know your ID number, check with the Office of the Provost. If you already have an ID and have forgotten your PIN number, go to the PIN retrieval site at:

https://domweb.dom.edu/retrievePIN/

(You may be prompted for your Dominican network name and password to gain access. The dialog window you see will be the same as shown for off-campus e-mail access or off-campus network drive access.)

We have some documentation on retrieving class rosters and submitting grades online using Campus Web at the following address:

http://domin.dom.edu/documents/campusweb/campuswebfaculty.htm

To retrieve information on your advisees, you must attend a mandatory training session that is held twice each semester before being allowed to access advisee information. Check the latest schedule of technology training workshops at:

http://domin.dom.edu/workshops/workshops.htm
How Do I Get Web Pages Up?

Any web page that you want to post should be copied onto your I: drive when you are on campus, which maps to our "Intranet." Such pages should first be in HTML format. If you want to post a home page, please name the main page index.htm and place it on your I: drive. After converting the document to HTML and posting it to your I: drive, submit a help desk ticket by clicking on the Contact the Help Desk link on the Information Technology page or going directly to http://domweb.dom.edu/helpdesk/. This will ensure a link is created from our Directory of Faculty Pages at: http://domin.dom.edu/facpages.htm

Once posted, your home page will be accessible for anyone at the following URL:

http://domin.dom.edu/faculty/username/index.htm

So, if your name is Pat Johnson, your home page address will be:

http://domin.dom.edu/faculty/pjohnson/index.htm

Please delete files you no longer use in your I: drive! Server space is limited!

How Do I Get My Class Syllabi Up On The Web?

You are encouraged to post your syllabi on our Intranet, too. For consistency, we strongly encourage you to name your various syllabi index.htm and place them in folders by course number on your I: drive (such as ENGL101, HIST101, etc.). Please do not include spaces in folder names, as older browsers may have difficulties getting into the folder. Information on copying your syllabi onto your I: drive is available from our Information Services documentation page at http://domin.dom.edu/documents/syllabi.htm and is called Steps for Loading Your Syllabus onto the DOMIN Server.

Make sure to check with the Dean of your school for syllabus content requirements.

Once copied onto your I: drive, submit a help desk ticket by clicking on the Contact the Help Desk link on the Information Technology page or going directly to http://domweb.dom.edu/helpdesk/.

Following the above guidelines, a syllabus will be accessible at the following address:

http://domin.dom.edu/faculty/username/coursenumber/index.htm

So, if faculty member Pat Johnson copied an English 101 syllabus onto the I: drive, the address to access it would be:

http://domin.dom.edu/faculty/pjohnson/engl101/index.htm
Do You Have A Template I Can Just Fill In?

We have a template posted on our intranet to assist you in posting a syllabus on the Web. This template is already in HTML format and can be opened up and edited in Word. There are directions within the template on what to do. To download this template, see the page at:

http://domin.dom.edu/documents/syllabi.htm

How Do I Convert Something to HTML For The Web?

The easiest way for most people to convert something to HTML is to use the University's standard word processing package, Microsoft Word (which you have on your computer) and convert a document to HTML using the File... pull-down menu, then Save as Web Page. Make sure the Save as type drop-down menu is set to Web Page (*.htm; *.html if you have allowed viewing file extensions) and not to the default setting of Single File Web Page (*.mht; *.mhtml).

Word does not always provide a perfect translation to HTML, however, and you may have to do a bit of "cleaning up" for documents (such as syllabi) that you want to convert to HTML. We have a few guidelines posted on a document called Saving Your Word Documents to HTML available via our syllabus documentation page at:
http://domin.dom.edu/documents/syllabi.htm

Here's the best tip: put things like your course calendar or list of readings in tables! Using tabs in a document you plan on saving to HTML can have very unexpected results.

Can My Students Have Web Pages?

Yes, they can. Your students will need to fill out an Application for Web Account form, which is available at the Technology Center Lab Assistant's desk. This form is also available for downloading in PDF format at http://domin.dom.edu/documents/network.students.htm

Your students will then have an I: drive (like you do) for posting Web pages. Your students should name their home page index.htm. They can also create folders if they would like to have Web pages for specific classes. If your students would like to have their pages linked by name from our Directory of Student Pages at http://domin.dom.edu/stupages.htm they should call the IT Help Desk at ext. 6832 or send an email to helpme@dom.edu.

Can I Access My Web (I:) Drive From Off-Campus?

If you have a web drive (typically assigned the letter I:, although if you're in charge of departmental web space, that would like be assigned the letter W: ), you can access and add to files to your drive from off-campus in the same way you can to your N: drive. The steps for doing this, however, are a bit different, since the procedure involves using FTP (which stands for file transfer protocol--not that you asked).

The easiest way to access the files is similar to accessing your N: drive: by using Internet Explorer. Please note that this is not encrypted and therefore should not be used if you are accessing sensitive information. (And if it's sensitive, it should not be on your web drive to begin with!) Also, there are several known Macintosh issues that vary with the OS being used. Contact the IT Help Desk at ext. 6832 or submit a help desk ticket by clicking on the Contact the Help Desk link on the Information Technology page or going directly to http://domweb.dom.edu/helpdesk/. Be sure to know the OS version you are using before doing this.

The address you type into the Address box will be the following:

ftp://domin.dom.edu/faculty/username/

Note that you do NOT type in http://, but rather ftp://. So, if you are a faculty member named R. Johnson who wishes to update material on your web drive, you would type in:

ftp://domin.dom.edu/faculty/rjohnson

You will then see the following dialog box:
Be sure to type in your entire Dominican email address (including the @dom.edu) and then click the Log On button. When successfully logged in, the appearance will be very similar to accessing your N: drive from off-campus, as described above. You can copy and paste files or folders from your home computer to the web drive. Should you want to place a web page in a new folder, you can create a new folder by clicking File>>New>>Folder.

Complete documentation on accessing your web drive from off-campus, including publishing web pages onto your web drive while using Dreamweaver from home, is available via the Information Technology page at: http://domin.dom.edu/infotech.htm
SOFTWARE INFORMATION

Which Software Packages Does Dominican Support?

Dominican University presently supports Outlook for its e-mail system and the Office suite for individual applications (Word, Excel, Outlook, PowerPoint, and Access). All personal computers in faculty offices, the Technology Center, and computer-equipped classrooms should have these programs. The majority of the campus is using the latest version, Office 2003. There is also a virus-scanning program (Symantec Antivirus--commonly called "Norton") installed on all faculty and staff computers, Technology Center computers, and computer-equipped classrooms.

Regarding Web-based resources, we support Internet Explorer (versions 6.x and above) for Web browsing and Blackboard (version 6.3) for Web-based course management. We recommend the use of Word for converting documents to HTML if you want the conversion done quickly and with a minimum of fuss, although we have a "real" web editing package (Dreamweaver MX 2004) installed on machines in the Technology Center should you wish to use it. (Note that Microsoft's FrontPage is no longer bundled with Office and is therefore not supported.)

So, what does "support" mean? It means if something goes wrong with one of these packages, IT will do its best to find a solution to the problem. It also means if you have a question about a specific aspect of one of these packages, that they will try to find an answer. On the other hand, if you have a question about a package not supported (such as WordPerfect, Quattro Pro, or Crossword Puzzle Builder 2.0), IT will try to help you (being helpful folks by nature), but certainly cannot guarantee a solution and cannot even guarantee it can be looked at, depending on other service requests being handled.

How Do I Learn About the Software Supported by Dominican?

If you would like to learn more about how some of the software that we support works, your best option is to go to one of the Information Technology workshops offered throughout the Fall and Spring semesters. A schedule is always distributed via campus mail and is also available on the Intranet at: http://domin.dom.edu/workshops/workshops.htm.

There is also documentation on the Office suite of products at: http://domin.dom.edu/documents/office.htm. Although the majority of this documentation still covers Office 2000, the information conveyed remains applicable to Office 2003.

What Software Is Loaded Where?

As mentioned above, Office 2003 is virtually everywhere. To find out the room numbers where other software is loaded, there is a very nifty software inventory available at the following address:

http://domin.dom.edu/Intranet/softwareinventory.aspx

Or, simply go to the ever-handly Information Technology page at http://domin.dom.edu/infotech.htm and follow the link for Software Inventory.
**I Found A Software Package That's Perfect For My Class. How Do I Get It Loaded Onto Technology Center Computers?**

Assuming that you have a *legally purchased* software package with *licensing for the number of computers you want it loaded on*, you should submit a help desk ticket by clicking on the **Contact the Help Desk** link on the Information Technology page or going directly to **http://domweb.dom.edu/helpdesk/**.

If you do not have the proper licensing, you will be asked to get it. (We are *not* overly anxious to be visited by the Business Software Alliance anytime soon, and certainly do not want publicity in *The Chronicle of Higher Education*--at least not on this topic!)

**Can I Get A Copy Of Programs For Use At Home?**

Our licensing simply does not support the use of personal copies of software. As a faculty member at an educational institution, however, you are in a position to take advantage of some discounted software deals that many software makers give to faculty members and students through local computer stores or over the web. (Try typing in **academic software discount** in Google and you'll get more sites listed than you'll know what to do with.) Most of the vendors will require a photocopy of your faculty ID when you order. Also, check the Information Technology page at **http://domin.dom.edu/infotech.htm** and check the area titled **Software Purchases**.
How Do I Get a Computer To Use In the Classroom For Myself?

If you want to use a computer for instructional purposes in a non-computer classroom or have one available for your students to give presentations in class, you should contact the Media Center in the Rebecca Crown Library at ext. 6888 to arrange to have a notebook computer delivered to your classroom, along with a projector to display what is on the screen. You should also notify the Media Center if you plan on connecting to the network.

Dominican University has six Enhanced Learning Environment classrooms that have a networked personal computer (with a ZIP drive, USB drive, and DVD drive), screen, projector, a VCR, and sound system in the following classrooms: Lewis 204, Lewis 301, Lewis 310, Lewis 312, Lewis 334, and Priory 259. Over the Christmas break, Fine Arts 212 will also be converted to an enhanced classroom. Scheduling is extremely tight for these rooms, however, so to request these classrooms you must contact the Registrar's Office at ext. 6774. Also, all four classrooms on the third floor of Crown have--at the very least--an instructor's PC with projector.

How Do I Get a Classroom With Computers For Each Of My Students?

Dominican University has six Windows-based classrooms that are equipped so that each student has a personal computer, as does the instructor. (The instructor's PC is also hooked up to a projector and room-wide sound system.) These classrooms are Lewis 002 in the Technology Center (30 student computers), Lewis 004 in the Technology Center (25 student computers), Lewis 130 (21 student computers, 2 instructor's computers), Crown 111 (24 student computers), Crown 330 (31 student computers), and Lewis 131 (27 student computers--no room-wide sound system, though the instructor's computer has speakers attached). All PCs have CD-ROM drives with burners. Lewis 002 and 004 have DVD drives (with CD burning capability). In addition, Crown 202 is a classroom with some multimedia software (Photoshop, video editing) and has 24 student computers: 6 are Macintosh-based computers, 18 are PCs, and there is one PC-based instructor's station.

We also have a classroom equipped with 21 Macintosh-based computers and 4 PCs in Lewis 406 called the Digital Media Classroom. (The instructor's machine is a Macintosh.)

Contact the Registrar's Office at ext. 6774 for all requests for the use of these classrooms.
NUMBERS TO CALL

General IT Help Desk Number: 6832

Classroom Equipment Problems

Call the Media Center in the Library at ext. 6888 if your classroom is:

Lewis 204, Lewis 301, Lewis 310, Lewis 312, Lewis 334, or Priory 259 (classrooms with the Enhanced Learning Environments) or any Crown classrooms.

If you are using a notebook supplied by the Media Center that was delivered to your classroom, you should contact them at ext. 6888.

All other classrooms--contact the IT Help Desk

IT HelpDesk Web Site

If you encounter a computer-related difficulty, you should submit your request for service on the IT HelpDesk Web site at:

http://domweb.dom.edu/helpdesk

Because it is on a secure server, you will first be prompted with a dialog box to enter your user name and password. (This is true even if you're on campus. It is the same login screen shown previously on page 13.) After doing that, you will see the following screen:
At this login screen, type in your e-mail user name including the @dom.edu extension. (Example: if your name is Jill Smith, you would type in jsmith@dom.edu.) The first time you use this system, you will not have a user name. Click the register link and fill out the form presented. (You will only have to do this once.)

This HelpDesk service is available only to Dominican University faculty and staff.

If you have problems with a computer in your office or the Technology Center, such as not being able to get it to print or finding something isn't working correctly, contact the IT Help Desk at ext. 6832.

Be sure to check the Information Technology web page at http://domin.dom.edu/infotech.htm for links to information and documentation.